Office 2000 Resource Kit ReadMe

The Office Resource Kit ReadMe file is organized into two sections, Issues and Errata. The Issues section contains information regarding deployment performance, configuration, suggestions for problem avoidance, and known pitfalls that may obstruct the ability to install and use important segments of Office 2000. The Errata section contains corrections to the Office Resource Kit documentation which were discovered after it was submitted for publication. Each Errata entry title contains the path (based on titles and headings) for discovering the location for correction.

Issues

16-bit applications – Excel 5.0 Converter Pack process installs incorrect files

If you run the Converter Pack on a system with Excel 5.0 installed, it will unintentionally install the files XLQPW7.exe (Quattro 7/8 converter) and OpenWB3.xla. If you attempt to run XLQPW7.exe, it attempts to run in 32-bit mode. XLQPW7.exe is a 16-bit utility and will not work in 32-bit mode. Delete these two files if you find them on your system after running the Converter Pack.

Always Install with elevated privileges – Policy issue

If you intend to use the “Always install with elevated privileges” policy setting for a users machine, take note that the “Always install with elevated privileges” policy is enforced on a users machine only if both instances of the policy in the Computer and User settings groups are set to ON. 

To set the “Always install with elevated privileges” policies:

1 Make sure the Instrl1.adm template is loaded into the System Policy Editor before you open any saved policy file.

2 Open the Default Computer (or your specific Computer policy group) and select Windows Installer.

3 Select the Always install with elevated privileges check box.

4 Select the Check to force setting on, uncheck to force setting off check box.

5 Repeat Steps 2-4 for the Default User group or for a specific user.

Banyan Vines Server – Cannot complete install of Office 2000

If you create an Admin image of Office 2000 on a Banyan Vines Server, and you want to install Office 2000 so the program files run from the network server instead of being installed to the users local drives, you must make changes to the install process. The problem stems from the Banyan Vines Server not being available after the Office 2000 setup process reboots to complete setup and configuration. If the Banyan Vines Server is not found, the install process aborts, leaving registration of several file types, and other lesser issues, unfinished. The following is an outline of the possible steps you can take to avoid this issue.

Note: This is not a tested and approved process, it is a suggested course of action and is up to the administrator to resolve any issues not covered in the outline.

1 Change the REBOOT property on the Setup command line to REBOOT=ReallySuppress.

2 In the Windows registry, move the Windows Installer RunOnce command from the HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\RunOnce subkey to another private registry key (any key you create in the HKEY_CURRENT_USER registry key will suffice) or save it to a file on an available drive so after rebooting you can read it back into your program after restarting.

3 Reboot the system.

4 After the system reboots and the network connection is established, start the Windows Installer with the command line saved in the private key or file (from Step 2). 

5 Delete the temporary registry key or file (from Step 2).

Beta installs – Admin image install error

If you have been part of the beta testing of Office 2000, you may encounter the following error message if you are performing an install using the /a setup option:

Error 1316: A network error occurred while attempting to read from the file <path>\install.msi.

To avoid or correct this situation, be sure to completely remove (uninstall) any previous beta releases of Office 2000 prior to performing an install from an admin image.

Changing installation states after Office installation - Filelist.xls – Feature tree list and hidden features

When you configure an initial installation of Office 2000 using a transform, you may want to hide features you do not want deployed during the initial setup.  Hiding features forces a user to see only the features (software and components) you choose to reveal.  Visible features appear in the Add/Remove Programs utility.  If you do not hide features you are not ready to deploy, users have the ability to install or modify them through the Add/Remove Program utility at any time – before you are ready to deploy the additional features or applications.

There is a condition involved with hiding features.  After you deploy a feature using the PropName=PropValue method, it remains hidden from the user in Add/Remove Programs.  This has no affect on the functionality of the feature, only on the user’s ability to configure it after installation.

If you modify the following property entries in the Setup.ini file [Options] section; ADDLOCAL, ADDSOURCE, ADVERTISE, or REMOVE, you must use the feature names found in the Filelist.xls file [<install path>\ORKTools\ToolBox\Docs Lists Samples\Office] to create valid PropName=PropValue pairings. Several features listed in this spreadsheet do not appear in the feature tree list of the Custom Installation Wizard and are noted in this spreadsheet. If you install the parent feature, you must also specify any of the related hidden features you want to install in the appropriate Property list. 

“Hidden features” refers to any features authored in the .msi file to never be displayed in the visible feature list within Setup or the Custom Installation Wizard (CIW). This does not apply to features you have selected to hide within the CIW.

Note: There will be an updated version of the Filelist.xls available on the Office Resource Kit web site (http://www.microsoft.com/office/ork). This update adds a new sheet in the Workbook containing a hierarchical list of all feature names, including the authored hidden features described above.

If you add features to these command line entries, you are restricted to a 1024 character limitation for each line (ADDLOCAL, ADDSOURCE, ADVERTISE, or REMOVE). If you need to include more features, you must create multiple Setup.ini files and link them together using a batch file. For example:

start /wait setup.exe /wait /qb /settings setup#1.ini REBOOT=ReallySuppress

start /wait setup.exe /wait /qb /settings setup#2.ini REBOOT=ReallySuppress

start /wait setup.exe /wait /qb /settings setup#3.ini REBOOT=ReallySuppress

.

.

.

start /wait setup.exe /wait /qb /settings setup#n.ini REBOOT=Force

See the topic “Setup.exe and batch files – using the ‘start /wait’ prefix” for further information on the use of start /wait.

You must use the Setup.exe available with the Office Resource Kit toolbox. See the topic “Setup.exe – Recommended upgrade version available with Office Resource Kit” for further information.

Also, as part of the Office Resource Kit, is an executable you can include in your batch file for forcing a reboot of your computer. Reboot.exe, when run, will shutdown windows gracefully and then force a hard boot restart of your computer. Look in: [<install path>\ORKTools\ToolBox\Tools\Package Definition Files] to find reboot.exe.

Configure Office Collaboration function – Internet Information Server 4 – Unavailable for use

If you attempt to select the “Configure Office Collaboration function” option of Internet Information Server (IIS 4) (right-click on the Default Web Site, select Properties, select Server Extensions tab from the Default Web Site Properties dialog) the feature is grayed-out and unavailable. There is no way to enable this option, however you can get to the intended function by entering http://name of machine/msoffice/msoadmin in the URL textbox of Internet Explorer or by choosing Run from the Start menu and typing the appropriate string.

Error applying transform error message 

If you configure an install of Office to begin from a Web hyperlink, you may encounter the following error:

Error applying transforms. Verify that the specified transform paths are valid.

This is due to an issue with Windows Installer not properly resolving the relative path of the source. See the topic “Setup.exe – UNC versus Drive letter startup issue” for further information. To avoid this issue, specify the full path to the .mst file and not the relative path.

Excel – Two-digit year always expands to four-digit year with all Far East operating system languages

When using Excel with Far East operating systems, entering a date with a two-digit year always expands to a four-digit year. There is no work around for this issue.

Excel 4 – High Security and .xlm add-ins

If you plan on using Excel 4 style macros (.xlm) you will need to add a registry entry to enable their use if you also plan on using High Security. Excle .xlm macros cannot be digitally signed and cannot load when High Security is enabled. Some Excel add-ins were created using .xlm. To allow add-ins written as .xlm macros to run as exceptions under High Security with Excel 2000, add the following registry entry.

[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Office\9.0\Excel\Security]


XLM
1 – dword

Creating and setting the “XLM” registry DWORD value to 1, allows users to load .xlm macros. Setting this value to zero defeats this feature and returns to the default behavior.

When this registry entry is added and set to 1, the end-user receives a warning about .xlm macros and has the option to open the workbook. End-users should run a virus check on any .xlm prior to using it. Even though .xlm macros are allowed through the High Security check, the High Security feature for VBA macros is still enabled.

Use of this option is similar to that of Medium Security except it allows for automatic and silent disabling of non-signed VBA macros (a feature of High Security). The administrator of the machine can force the running of signed and trusted VBA macros, but also allow exceptions for Excel 4 macros. If this option is used, users should be educated about Excel 4 viruses and how they are enabled if the workbook is opened.

Note: Addition of this registry entry provides no indication through the User Interface to the end user that the system is running a modified/lesser version of High Security.

Excel Microsoft Query – Intllimit.xls – error regarding Traditional Chinese codepage requirements

Intllimit.xls contains an entry for Excel Microsoft Query stating “Traditional Chinese user interface available on Traditional Chinese system locale only.”  This is an unnecessary entry. Microsoft Query is ANSI format and must match the system code page. If it does not match the codepage, it defaults to English.

Far East languages – Non-core international support files – User interface corruption with Windows NT 4.0 (with SP 4) in locked-down configuration with Active Desktop (modified 8-27-99)

If you install the MultiLanguage Pack using the /j setup option (to deploy Office 2000 and the MultiLanguage Pack) and have Active Desktop, then change the codepage/language settings from any non-Far East language to a Far East language, like Chinese or Korean, your User Interface will corrupt when you start any Office 2000 application. This is due to National Language Support (NLS) files not being copied to the system during setup by default. When the Office Tools, International Support Files, and core support files are installed locally, the issue is resolved.  By default the feature Extended Support Files is set to Not Available, it is advised to change it to Run from My Computer to enable the recognition of more codepages and character encodings.

Find Fast – May cause unresponsive system

If you use Find Fast, be aware that it is a disk-intensive program. It may appear to suspend applications when it begins to index a drive, and may degrade performance for all drives indexed. It is recommended to reduce the indexing interval from the two-hour default, to at least an eight-hour period. It is even advised to reduce it to once in a 24-hour period and to have it run during a time when a user is not present on the system.

It is also recommended to not run Find Fast on a server during a period of expected usage by client systems since it will give the appearance that the server is down or unavailable.

Find Fast – Does not automatically create an index for each local, fixed volume after initial installation.

If you want Find Fast to automatically create an index for a specific drive, you must manually add or modify, the registry entries for the following key. During installation of Office 2000 the Find Fast indexes are not created by the Windows Installer process.

[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Office\9.0\Find Fast\Index List\Index 00]


Folder


[DrivePath] <-- Replace with drive name (i.e. “C:\”)

Type


0 
dword


Property Cache

1
dword


Automatic

1
dword


Index Operation

1
dword

After creation or modification of this registry key, open the Find Fast application in the Control Panel. If you successfully created or modified the registry key, it will automatically begin creating an index file of all files present on the drive you specified in the “Folder” entry of the key. An index is not created until you run the Find Fast utility in the Control Panel or Find Fast is started by the Office Startup Assistant (osa9.exe –b –l). Reboot the computer to validate that Find Fast has been added to background tasks and examine the Task Manager for FindFast.exe.

Note: FindFast is a disk intensive program when it is indexing a drive. It may even appear to stall a drive when it is indexing. It is advised to increase the indexing interval to once in an eight-hour period of time, for instance, once at the beginning of the day, or at a time when the user is away from the computer.

Folder.asp – Active Server Page - AutoNavigation, Encoded characters in the URL

If you use the AutoNavigate viewing feature of the Folder.asp and access the string variable returned by the ActiveURL or CurrentURL properties, examine the URL to make sure it does not contain any encoded characters. You cannot use the URL as returned by the ActiveURL or CurrentURL properties if they contain encoded characters. The reason for this is that most non-alphanumeric characters in a URL become HTML encoded characters after they are submitted to the AutoNavigate feature. The characters are translated to the %xx HTML encoding protocol, where xx is the HTML encoding number for the given non-alphanumeric character. Any URL with an HTML encoded character is incompatible with processes/functions/methods not capable of interpreting HTML encoding of this format and should be converted prior to use.

If you intend to use the string within either of these two properties with external processes, convert all encoded characters back to their original form before submitting them.

Non-alphanumeric characters are:

@ : ; < > \ ” # % { } | \\ ^ ~ [ ] ` , & + = $

and any characters between 0x00-0x1f (ASCII 0 – 31) and  0x7f-0xff (ASCII 127 – 255)

HTML Help – does not work if Internet Explorer 5 is not installed/upgraded

If the administrator sets a policy to install all of Office 2000 with elevated privileges (Always install with elevated privileges - Instlr1.adm), but decides not to install/upgrade Internet Explorer 5 on a Windows NT 4.0 system, HTML Help will not work with Office. To correct this situation:

1 Log onto the user’s system as an administrator (or with administrator privileges).

2 From the Command Prompt (MS-DOS window) move to the Internet Explorer 5 setup directory in the Admin image created on the server.

3 Enter the following command line:

ie5setup.exe /c:”ie5wzd.exe /m: /q:a /r:n /E:Gensetup,HTMLHelp /s:””#e”””

- or –

Add the Ie5setup.exe command line option to the end of a setup batch file so it is run after Office 2000 has completed installation.

Run this process immediately after Office 2000 is installed to the user’s system.

HTML Help – Hyperlink failure with Office 2000 on Netscape Navigator browser only systems

When a computer is configured to use Netscape Navigator exclusively (and Internet Explorer is disabled by the Proxy server), Office 2000 will encounter an error when attempting to execute an HTML Help hyperlink jump within an Office application. You can add or modify the following registry key entry to correct the error.

[HKEY_CURRENT_USER\Software\Microsoft\Office\9.0\Common\Internet]


“ForceShellExecute”
1 - dword

Change the ForceShellExecute entry to 1.

Internet Explorer Administration Kit (IEAK) – Custom Installation Wizard (CIW) silent install issue.

The installation selection for the Custom Installation Wizard (CIW) always includes the separate installation of the IEAK.  Since the IEAK Setup is performed silently, it always is installed in the default location.  This can have several side effects:

· If you currently have a version of the IEAK version 4 installed in the default location, the IEAK version 5 install overwrites the existing install with the new version.  The IEAK version 4 setup does not offer the ability to change the install location.

· If you have installed the IEAK version 5 from the Web, you may have a later version than that supplied with the Office Resource Kit. In this case, when you install the Office Resource Kit and reach the IEAK portion of the installation you will see a standard "Confirm File Replace" dialog. To preserve your later version of the IEAK answer "No to all". If the version you installed from the Web is older it will automatically be updated to the newer Office Resource Kit version.

Internet Explorer 5 – Windows NT 4.0 locked down – Install order prevents use of oleaut32.dll

If you install Internet Explorer 5 on a locked-down Windows NT 4.0 system prior to installing Office 2000, you will encounter a problem after Office 2000 is installed. Installing Internet Explorer 5 prior to Office 2000 sets the oleaut32.dll to a permission setting other than Everyone. When this happens, some DLLs will not run (i.e.: riched20.dll, stdole.dll) and will cause PowerPoint and sections of Word to spawn alerts and error messages. This is not an issue if Internet Explorer 5 is installed with Office 2000.

To correct this issue, if Internet Explorer 5 was installed prior to Office 2000, set the oleaut32.dll group permissions to Everyone.

Internet Explorer 5 – Internet Connection Wizard, restricted from running

If you are using Windows NT 4.0 with Service Pack 4, or Windows 2000, you may encounter the following error the first time you attempt to use Internet Explorer 5 if you log on to your system without administrator privileges.

Access Denied: You are restricted from running the Internet Connection Wizard because you are not an administrator on this machine. 

In order to avoid this message, you must log on with Administrator privileges when you decide to run Internet Explorer 5 for the first time. When the Internet Connection Wizard completes, and Internet Explorer 5 has access to the web, you no longer are required to logon as an administrator.

Internet Explorer 5 – .ocx installation/download under Windows NT 4.0 Service Pack 4 with high security option

When using Internet Explorer 5 on a Windows NT 4.0 system with Service Pack 4 installed, you will not be able to install an .ocx control when NT security is set to High. Since many Web sites download .ocx’s, you should consider the tradeoff between functionality and security. Setting security to any level below high allows .ocx controls to install.

Internet Explorer 5 – Requires extra reboot after install on systems with Lotus Smart Suite

If you are installing Internet Explorer 5 to a system with Lotus Smart Suite already installed, there is a possibility you may require an extra reboot. This is not a problem, it is by design to overcome a lock on the Wininet.dll by Lotus Smart Suite. If you have Internet Explorer 4.0 or 4.01 already installed on the target system, you will not encounter this issue.

Language settings – LCID not removed after uninstall of Office 2000

If you install US Office 2000 on a localized operating system, and then later uninstall it, the uninstall process does not change the LCID back to the settings of the localized operating system. If you then install a localized version of Office 2000, you will have the wrong settings and will encounter problems with codepage dependent applications and utilities. To correct this situation, run Langver.exe and set the LCID to the correct settings for your localized operating system (or use the /LCID Auto command line option with Langver.exe). For more information, see the Readme topics “Langver.exe – Setting LCID from within a batch file process” and “Langver.exe – Possible language settings corruption.”

The following table summarizes the different scenarios for mixed language installations of the operating system and Office 2000. 

	Operating System
	First Installation
	Upgrade or Reinstallation
	Need Langver?
	Comment

	Localized
	English O2K
	Localized O2K
	YES
	Use to set Install Language to Local language.

	Localized
	Localized O2K
	English O2K
	YES
	Use to set Install Language to English.

	Localized
	Localized App X
	English App Y
	NO
	Install language will be localized and English app will behave correctly.

	Localized
	English App X
	Localized App Y
	YES
	Use to set Install language to Local language

	Localized
	Localized App X
	Localized App Y
	NO
	

	Localized
	English App X
	English App Y
	NO
	

	US
	English Office + LPK
	
	Optional
	Use to set all defaults to a specific language. (for advanced users only)

	US
	English Office
	Localized Office
	Not Supported
	Not a supported configuration.


Langver.exe – Possible language settings corruption

When using Langver.exe, there are instances where possible unintended side effects may cause corruption of user preferences/settings, operating system settings, and/or application startup configuration. Langver.exe is only for use with:

1 English version of Office 2000 with the MultiLanguage pack installed on a localized operating system.

2 Mix of English version of Office components and localized components, where a localized component was installed after the English version was installed.

Use of Langver.exe on localized systems can corrupt the MAPI, encoding, spell checker, proofing tools, sorting, localized add-ins, and wizards. Use of Langver.exe on non-English operating systems with incorrect settings, forces Office 2000 to run in “fall-back” mode. Fall-back mode might cause incorrect startup of Office, use of the wrong version of Help, or the display of the incorrect User Interface. If you need to change settings for Office, use the SetLang.exe utility to adjust language settings. Using SetLang.exe protects the user from unintentional changes to language critical settings.

LCID – Setting LCID from within a batch file process

If you need to specify the LCID (installation language) for Office from a batch process, you can use the Langver.exe utility and add a command line option. The option /LCID can accept either the LCID (example: langver /LCID 1041) or “Auto” (example: langver /LCID Auto). Any entry not recognized by Langver.exe as a valid LCID is ignored. 

Specifying the /LCID option on the command line disables the User Interface for the Langver.exe utility.

If you run Langver.exe with the /LCID Auto option, Office configures itself to the language used by the operating system. This option is different than just starting the utility without the /LCID option. Starting Langver.exe without /LCID displays the UI, and if you select OK, it keeps your current settings (without defaulting to the operating system settings). If you run with /LCID specified, it will reset the system to the operating system settings (which may be different than what you had originally set through the UI).

If you use Langver.exe, consider any unintentional effects to the Normal.dot template of Word 2000 by a change to the LCID and any user settings, which may be overwritten because of this change. If you run Langver.exe, it resets the Normal.dot to the new language/codepage settings and will delete any previous language settings.

Macro Security – Security set to High still allows users to override customized settings

When macro security is set to High, it is still possible for a user to override customized settings. It is possible for a user to select the checkbox “Always Trust this Source” option and set it to True when the system asks a user to accept a given executable from an external source, thereby allowing a possible virus to enter into the system. To prevent this, move the trusted list from the [HKEY_CURRENT_USER\Software\Microsoft\VBA\Security\Trusted] key entry to the [HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\VBA\Security\Trusted] key entry and remove the list from the previous key entry. This does not change the Checkbox State in the interface, but it does keep the user from enabling macros the administrator has chosen to avoid.

MAPI – Failure with Internet Explorer 5

If you have an .ocx making calls into the MAPI (Microsoft Messaging Application Programming Interface) to create and send automated mail messages, you will encounter an error when Internet Explorer attempts to use this .ocx. The error is due to CDO (Collaborative Data Objects) not being registered or installed. To avoid this issue, install CDO.

MultiLanguage Pack installation – US and MultiLanguage Packs single install example (modified 8-27-99)

If you need to install Office 2000 and the MultiLanguage Pack in one step, use the following process.

1 Create an admin image of Office.

2 Create an admin image of the MultiLanguage Pack.

3 Replace the Setup.exe in the MultiLanguage Pack admin image with the new version of Setup.exe found on the Office Resource Kit.

You can get the new Setup.exe from the Office Resource Kit CD-ROM (<CD Root>:\PFiles\ORKTools\ToolBox\Tools\SETUP\SETUP.EXE), or you can download it from the Toolbox in Office Resource Kit Web site at http://www.microsoft.com/office/ork/.

4 Create a transform for Office using the Custom Installation Wizard.

5 On the Add Installations and Run Programs panel of the wizard, add the command line to install the MultiLanguage Pack and include the new /chained option. For example:

<fully qualified UNC and path>setup.exe /chained TRANSFORMS=lpksettings.mst

6 Deploy Office using this custom transform.

When the Office install completes, the MultiLanguage Pack installation will begin automatically.

Using the /chained option results in the MultiLanguage Pack install waiting until the Office 2000 install is completely finished before starting. The one requirement is for the Office install to finish completely. You can also use this same Office 2000 transform to make other customizations to your Office 2000 deployment. For example, you can add custom files, registry keys, or any customization allowed by the Custom Installation Wizard.

Note:  You can also use the chained Setup.exe when creating a transform for the MultiLanguage Pack to start the installation of a second MultiLanguage Pack CD or even another product. It is possible to chain many installs together by using this mechanism, however, it is recommended to only chain a few.

ODBC – Translation error on a locked-down system

If you attempt to use ODBC on a locked-down system with an upgraded MDAC of version 2.1 (the version shipping with Office 2000), you may encounter an error if you are using Jet database drivers from Office 95 (DAO 2.5, Access 95) and earlier versions. During the first attempt by an application to open a system Data Set Name (DSN), the driver attempts to upgrade the DSN. This process fails when it attempts to open the registry key [HKEY_LOCAL_MACHINE\SOFTWARE\ODBC] because the application does not have permission to write to this registry key. The driver fails to load, and then displays the Translation Error message. To avoid this condition, install MDAC version 2.5 (shipping with Windows 2000).

As a workaround to this situation, an Administrator would need to:

· Remove the offending DSN before upgrading and then recreate the system DSN after the upgrade.

-or-

· Open a connection with administrator privileges using the DSN (in order to have permissions to rewrite content).

-or-

· Allow write permissions to the [HKEY_LOCAL_MACHINE\SOFTWARE\ODBC] portion of the registry by all users.

User-created DSNs do not encounter this issue since DSNs created by users are in the [HKEY_CURRENT_USER\Software\ODBC] key and users have access to this registry for read/write.

Office 2000 – Run From Network (RFN) uninstall fails if source files are not available

If you install Office 2000 configured to run from the network, and later choose to uninstall it, the source install point must be available in order to have Windows Installer properly remove the application from the client’s local system. If the source install location is not available to the Windows Installer program, it will not remove the installed files on the user’s local system.

Office 2000 – Does not start

If you run setup with the /jm option (advertise) on a locked-down system to advertise Office 2000 but the user installs Office 2000 from a non-administrator install point (for instance, the CD), Office 2000 will not start. To avoid this issue, install Office 2000 from the administrative installation point created by the administrator.

Office 2000 – Unexplained shutdown after startup

If a non-administrator installs an Office 2000 image on a locked-down system using the /j or /jm setup option, when Office 2000 is installed to a clients system and started by a user (and asked to register), it may shutdown after what appears to be a normal startup. This is a license verification issue and is by design. Applications loaded to a locked-down system are expected to have been placed there by an administrator. After the administrator has created the image and registered it using the product verification number from the CD, the application should be available for use without requiring the product registration number.

Office content added with transforms – Office 2000 user configuration settings retained after uninstall

Note   the following only applies to installations of Office 2000 installed using a transform developed with the Custom Installation Wizard.

Most of the content you can add to an Office installation with a Custom Installation Wizard (CIW) transform is regarded as permanent. If Office is removed, this content is not uninstalled and it is not reinstalled if Office is reinstalled. This prevents an accidental overwrite of user customized settings and content if Office is reinstalled.

If necessary, a reinstallation of added content is possible. The controlling registry values are contained in the following key.

[HKEY_CURRENT_USER\Software\Microsoft\OfficeCustomizeWizard\1.0\RegKeyPaths\<GUID>]

If you want to allow the update of Office applications and related settings, use one of the following procedures.

If Office 2000 has not been uninstalled from the computer, you can find the appropriate <GUID> by using the following procedure.

1 Start Windows Explorer.

2 Navigate to the Installer folder containing the cached transform used during the installation.

For systems with machine installs, the default on NT, and for Win 9x systems where All Profiles is enabled and the Start menu is shared, look in. C:\<windir>\Installer\<GUID>. Note the Installer folder is a Hidden folder.

For Win 9x systems without User Profiles, at the time Office was installed, look in 
C:\<windir>\Application Data\Microsoft\Installer\<GUID>.

For systems with user profiles which are not described above, look in 
C:\<windir>\<user profile>\Application Data\Microsoft\Installer\<GUID>.

These folders may contain one or more cached .mst files. The appropriate folder will contain the cached .mst file applied during product installation.

3 Use the <GUID> folder name the mst file is stored in on the drive as a reference for searching/identifying the appropriate registry entry.

If Office 2000 has been uninstalled from the computer, you can find the appropriate <GUID> by using the following procedure.

1 Find the Administrative Installation Point where Office was installed from.

2 Find the .mst file used to install the original instance of Office 2000.

3 Right-click the .mst file and click Properties.

4 In the Properties dialog, click the Summary tab and look in the Subject field. Check to see if the .mst file is for the version of Office originally installed on the computer (premium, professional, standard, etc).

5 If the .mst file is the correct one, click the Statistics tab. In the Revision Number field is the GUID for Office. The GUID is the first numeric string in curly braces in the Revision Number field. You can copy the string and paste it into a text file if you need to.

When you have the correct GUID, you can search the registry for the [HKEY_CURRENT_USER\Software\Microsoft\OfficeCustomizeWizard\1.0\RegKeyPaths\<GUID>] key. The key will contain one or more of the following Value Names.

· OCWAddedContentWritten - controls Registry Keys, Shortcuts, added files, and added Installations or Programs in the transform. The presence of this key instructs the Windows Installer to not overwrite configuration settings (excepting the OPS content which is controlled by the OCWUserDataWritten key entry).

· OCWUserDataWritten - controls any content added from an OPS (Office Profile Settings) file. The presence of this key instructs the Windows Installer to not overwrite Profile Settings.  If removed, a reinstall of any OPS file settings occurs.

· OCWOutlookSettingsWritten – controls Outlook settings.

You can force a reinstall of Installations or Programs, plus missing files or Registry entries that were added by the .mst file. Delete the appropriate Value Name prior to the reinstall. 

Note   Remaining added content Registry entries may be overwritten by the reinstall as well.

If you cannot determine which specific values to remove using the previous steps, you can attempt the following global procedure. If you know you want to reinstall an instance of a Windows Installer application and allow update of content added with a transform (related to this application), you can remove the following key in its entirety.
[HKEY_CURRENT_USER\Software\Microsoft\OfficeCustomizeWizard]

However, the effect of removing this key is that any application installed with a transform will now reinstall any added content. This occurs because the controlling registry values for all installer applications have been removed.
OSA9.exe – Office Startup Assistant command line options

Office Startup Assistant (OSA) launches various Office 2000 utilities and features (e.g. FindFast, Office Shortcut Toolbar (OSB), New Office Document, Open Office Document). It also provides boot time initialization benefits for applications by initializing common fonts and OLE. OSA is designed to launch Office utilities at login time. This happens when Setup.exe adds the shortcut “osa9.exe –b –l” to the user’s startup group. The –b and –l command line options launch FindFast and OSB based on the user’s registry settings. It also provides an entry in the start menu for the “Open Office Document” (–f) and “New Office Document” (–n) dialog shortcuts. OSA can launch OSB (–o) or the current screen saver (–s). In a Run From Network environment, it is recommended to install OSA to the local system, especially if Outlook is installed locally as well.

-b
Start the Office Shortcut Toolbar (when used in conjunction with –l)

-f
Start the Open Office Document (File Open/Save As dialog)

-l
Start FindFast

-n
Start the New Office Document dialog

-o
Start the Office Shortcut Toolbar

-s 
Start the current screen saver.

OSA will launch the OSB if the following registry setting is present:

HKEY_CURRENT_USER\Software\Microsoft\Office\9.0\Shortcut Bar


AutoStart
1 - dword

OSA will launch FindFast if FindFast.exe is present and the following registry is not present:

HKEY_CURRENT_USER\Software\Microsoft\Office\9.0\Osa\Autostart


NotFindFast
1 - dword

Typically, when OSA9.exe is present in the startup folder, it has the –b and –l switches set (osa9.exe –b –l).

OSE/Frontpage/Windows 2000 – No access to Web Server registry keys with Windows 2000

If you logon to a Windows 2000 system and try to change any features which attempt a write or edit of the Web Server registry keys, the changes will not succeed. With Windows NT 4.0 this is not an issue. The increased security configuration for Windows 2000 allows only Power Users and above to have Full Control access to the registry. To avoid this issue, log on with at least Power User privileges prior to adding any application making modifications to Web Server registry key entries. If it is not possible to logon as a Power User, but you still want OSE admins to have write access to the registry, have the machine administrator perform the process listed below.

1 Start regedt32.

2 Select or add the following subkey.

HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Office\9.0\Web Server

3 On the Security menu, click Permissions, and then click Add.

4 Select the OSE Admins group

5 Click Add.

6 Set Type of Access to Full Control and click OK.

7 Select the Replace Permission on Existing SubKeys check box and click OK.

Outlook – Data loss with versions prior to 8.02 when accessing PST files of Outlook 9x and Outlook 2000

If users with Outlook 2000 have a personal folder file (PST) with any individual folder containing 16,000 or more items and the “Allow Large Tables” feature is enabled, they will encounter data loss if they roam to the PST from a version of Outlook 8.02 or earlier. You should upgrade all computers to a release of Outlook 8.03 or higher if you want to avoid this issue. If you do not upgrade, users should be told to reduce the number of entries in all individual folders to less than 10,000. This issue also applies to e-mail archived or autoarchived to a PST by Outlook 9x or Outlook 2000 and accessed from any version of Outlook earlier than 8.03.

Outlook 2000 – Does not run locally if Office 2000 is installed as Run From Network and network share is unavailable

If you are using the Custom Installation Wizard (CIW) to install Office 2000, and you have the top branch in the CIW set to “Run from Network,” but set Outlook 2000 to install with “Run all from My Computer,” Outlook will not run if the network share for Office 2000 is unavailable. Shared files used by Outlook are present on the Office 2000 server share and cannot be accessed. To avoid this issue, set the top node to “local.”

Outlook 2000 – Terminal Server - NetMeeting does not work

If you attempt to use NetMeeting with Terminal Server, it will fail. It is recommended you remove NetMeeting from computers using Terminal Server by running the Add/Remove program in the Control Panel.

Outlook 2000 – Terminal Server – OLE embedding failures in email messages

If a Terminal Server connection is established using the Client Connection Manager (CCM) to run Outlook on a server and the “Prompt me for a profile when starting Outlook” is checked (the default), OLE embedding features will not work. The failure is associated with multiple simultaneous connections and an OLE configuration issue. To avoid this issue, install the latest Terminal Server Service Pack, available from the Windows NT Server Downloads page on http://pbsweb2/NTServer/all/downloads.asp. This update to Terminal Server prevents “Multiple Outlook Sessions” from being started.

Outlook 2000 – Terminal Server performance issue

To increase the performance of Terminal Server, it is recommended that you disable the “Publish Calendar to Web” option within Outlook. If you want to use the Publish Calendar to Web feature, you must first unlock the [HKEY_CLASSES_ROOT\CLSID] registry node so users will have write access to this segment of the registry. 

To unlock the [HKEY_CLASSES_ROOT\CLSID] and allow users access to the CLSID keys:

1 Log on to the Windows Terminal Server computer as the administrator.

2 On the Start menu, click Run.

3 Type regedt32.exe and click OK.

4 Under HKEY_CLASSES_ROOT, select CLSID.

5 On the Security menu, click Permissions.

6 In the Registry Key Permissions dialog box, select the Replace Permission on Existing Subkeys check box, and then click Add. 

7 In the Name box, click Everyone, click Add, and then click OK.

If you do not want to give all users this access, you can add specific users or groups of users in the Name box, rather than selecting Everyone. 

8 In the Type of Access box, select Special Access, and then select the Query Value, Set Value, and Create Subkey check boxes. 

9 Click OK and close the Registry editor.

Outlook 2000 Custom Forms – Not accessible from locked-down Windows NT 4.0 systems

If [HKEY_CLASSES_ROOT] is locked-down (not writable), MAPI forms cannot be added to the system. To avoid this issue, do not lock down this registry key until after all forms are installed. To avoid future problems with applications attempting to register controls and forms in this registry key, consider not securing the [HKEY_CLASSES_ROOT] registry key.

This issue is also a concern for Outlook when used in a Terminal Server environment, since many different configurations of Outlook with Terminal Server and forms may be required by different users. It is recommended that you do not secure this registry key. This is especially important if users are creating custom forms and need to register them after creation.

If you need to register custom forms on a locked-down system, you will need to logon as an Administrator and register the control (since Administrator privilege can update the registry key). Keep in mind, some custom forms can attempt to write to the [HKEY_CLASSES_ROOT] registry key during use (even though they are registered, the design of the custom form accesses and modifies content in the registry for the given form during use). Forms of this type will not work on a locked-down system and should either be redesigned or the registry key should not be secured.

Outlook 2000 IMAP accounts – No means to configure with the Custom Installation Wizard (CIW)

Currently, no method exists to configure an Outlook Internet Mail Access Protocol (IMAP) account using the Custom Installation Wizard.

To add IMAP as a service to Outlook 2000:

1 On the Tools menu, click Services, click the Services tab, and then click Add.

2 In the Available information services box, click Internet E-mail.

3 Click OK.

4 Enter required information on all tabs in the Mail Account Properties dialog box.

5 Exit Outlook and then restart to initialize the new settings.

Outlook 2000 Meeting Calendar – Meeting disappears from calendar

If a delegate deletes a user’s meeting request after a meeting has been placed in the user’s calendar, the user’s meeting request will display “This meeting is not in the Calendar; it may have been moved or deleted.” To avoid this issue:

· Configure the delegate to be the only one who receives meeting requests. The user will not receive any meeting requests.

-or-

· The delegate should not delete meeting requests. This should be a decision the user makes (a procedural issue, not a software configuration issue).

Outlook 2000 Meeting Calendar – Two instances of same meeting

If an Outlook calendar is configured to receive meeting requests and has a delegate who also receives meeting requests, it is possible for duplicate meetings to appear in the user’s calendar. . To avoid this, have users use their online Calendar (not a local Calendar). 

To set this Calendar option:

1 On the Tools menu, click Options, and then click the Preferences tab.

2 Click the Calendar Options button.

3 Clear the Always use local calendar check box

4 Exit Outlook and then restart to initialize the new settings.

Outlook 2000, Schedule+, and Terminal Server – Unable to view Schedule+ calendar with a Terminal Server connection

If you attempt to use Outlook 2000 through Terminal Server and open a meeting request and direct book a Schedule+ account, you will encounter an error message “Cannot log on to Microsoft Schedule+. Unable to direct book a resource for this meeting.”  To avoid this, unlock (allow write access by affected users) the following registry key:

[HKEY_LOCAL_MACHINE\Software\Microsoft\Schedule+\Application]

Outlook versions prior to Outlook 2000 – Loss of data when roaming between earlier versions

If users roam and use different versions of Outlook, data loss may occur when using Exchange Servers. If roaming is important, it is best to facilitate a quick migration from earlier versions of Outlook to Outlook 2000. If upgrading is not possible, users who roam between earlier versions of Outlook and Outlook 2000, must be aware that data loss will occur when the expanded functionality of Outlook 2000 meets with the limitations of earlier versions of Outlook.

Password Protection – Disabling user access within the Save As/File Open dialog

If you need to disable the setting of password protection by users for Word or Excel files, you can disable the Password option by changing the policy in the Word or Excel user policies. This process turns off features in Excel. . Use only if it is absolutely necessary to disable password protection.

Before you disable the password setting option in Excel, make sure you have loaded the Excel policy templates.
Note: Do not load an existing policy until the policy templates have been added to the System Policy Editor.

To load the Excel policy templates:

1 On the Options menu, click Policy Template, and then click Add.

2 In the Open Template File box, navigate to the Windows directory (for example, WINNT, WINDOWS, WIN, and so on) and then to the INF subdirectory.

3 Select the Excel9.adm file and click Open to add it to the template list.

In the Policy Template Options box, click OK.

To disable the password setting option in Excel:

1 On the Start menu, point to Programs, point to Microsoft Office Tools, point to Microsoft Office 2000 Resource Kit Tools, and then click System Policy Editor. 

2 On the File menu, click Open Policy to use an existing policy, or click New Policy to create a new policy.

3 Double-click the Default User icon (or any other user or group that you want to set policy for).

4 In the Properties box, select the following policy: Microsoft Excel 2000 | Disable items in user interface | Custom | Disable command bar buttons and menu items.

5 In the Settings for Disable command bar buttons and menu items area, click Show.

6 
In the Show Contents box, click Add.

7 
In the Add Item box, type 4108, and then click OK.

This is the control ID for the General Options (Tools menu).

8 
In the Show Contents box, click OK.

9 
In the Properties box, click OK.

10 
Save your policy settings.

Before you disable the password setting option in Word, make sure you have loaded the Word policy templates.
Note: Do not load an existing policy until the policy templates have been added to the System Policy Editor.

To load the Word policy templates:

Note:   This procedure also disables access to the Tools | Options as well as the File Save As | Tools | General Options menu options. This restriction can present a major inconvenience to users.

1 On the Start menu, point to Programs, point to Microsoft Office Tools, point to Microsoft Office 2000 Resource Kit Tools, and then click System Policy Editor. 

2 On the File menu, click Open Policy to use an existing policy, or click New Policy to create a new policy.

3 Double-click the Default User icon (or any other user or group that you want to set policy for).

4 In the Properties box, select the following policy: Microsoft Word 2000 | Disable items in user interface | Predefined | Disable command bar buttons and menu items.

5 In the Settings for Disable command bar buttons and menu items area, select Tools | Options.

6 
Click OK.

7 
In the Properties box, click OK.

8 
Save your policy settings.

PowerPoint 2000 – Presentation Broadcasting feature does not work (aka: Windows Media Technologies server (NetShow) ) (modified 8-27-99)

When you attempt to run the Presentation Broadcasting feature of PowerPoint 2000 as a broadcasting server, it will not work. Office 2000 does not ship with the OnLBroad.exe file to enable Presentation Broadcasting from within PowerPoint 2000. To install this feature, connect to the following Web site http://www.microsoft.com/office/ork/2000/appndx/toolbox.htm to download and install the OnLBroad.exe or examine the tools folder of the CD.

Previous Office versions – Keeping and not installing over – Custom Installation Wizard issue

If you are using the Custom Installation Wizard to install Office 2000 on a computer hosting earlier versions of Office, you must not install to the same directory where a previous version of Office exists. The Custom Installation Wizard does not warn you about installing Office 2000 into the same directory as a previous version. If you choose to keep previous versions of Office, do not install into the same directory. If you do install over a previous version, you will have a mixed version situation with possibly corrupt registry settings and files.

Save As/File Open dialog – Places Bar customization

If you want to add user-defined entries to the Places Bar in the Office 2000 Save As/File Open dialog, modify or add the registry keys and entries described below. Office 2000 applications can display up to 10 user-defined items (Place1 through Place10). You can display only 5 user-defined items if you also show all the default-predefined items. If you disable the predefined items, you can display up to 10 user-defined items.

Add the “ItemSize” entry to the [HKEY_CURRENT_USER\Software\Microsoft\Office\9.0\Common\Open Find\Places\UserDefinedPlaces] and set it to 0 (zero). For example:

[HKEY_CURRENT_USER\Software\Microsoft\Office\9.0\Common\Open Find\Places\UserDefinedPlaces]


“ItemSize”
0 – dword

ItemSize sets the use of large or small icons in the Places Bar. You can only display 5 large icons if you set ItemSize to 1 (large icons). The Places Bar section of the Save As/File Open dialog does not scroll and limits you to a maximum of 10 items in small icon format.

Then add or modify the following key and associated entries:

[HKEY_CURRENT_USER\Software\Microsoft\Office\9.0\Common\Open Find\Places\UserDefinedPlaces\PlaceX] (where X is 1 – 10)


“Name”

“Shortcut Folder Text”


“Path”

“C:\”


“SortAscending”
1 – dword


“Index”

0 – dword

The values for the keys are as follows:

· Name is the text displayed in the Places Bar for the shortcut you are adding. 

· Path contains the entry to any drive or UNC path combination. 

· If SortAscending is set to 1 and Index is set to 0, it places the user defined item in ascending order within the list of user defined items.

· If Index is set to 1 through 10, the PlaceX Name entry appears in that position in the user defined list and ignores the sort order.

Do not change entries in the registry while a Save As/File Open dialog is currently open. When the dialog closes, it automatically overwrites the registry settings with the settings the dialog was opened with. 

To remove each default icon (Favorites, Web Folders, etc) add or modify the following registry key entries:

[HKEY_CURRENT_USER\Software\Microsoft\Office\9.0\Common\Open Find\StandardPlaces]

\Desktop


“Show”

0 – dword

\Favorites


“Show”

0 – dword

\MyDocuments


“Show”

0 – dword

\Publishing


“Show”

0 – dword

\Recent


“Show”

0 – dword

“Show” set to 1 displays the icon. “Show” set to 0 hides the icon.

Setup.exe - Destination Path – Character limitation

If you attempt to create an administrative install point for Office 2000 with the /a setup option and a path string longer than 260 characters (including filename, drive, UNC, etc) the setup will fail. You must consider the maximum number of characters in a path string before submitting it as a portion of a setup string.

Setup.exe – Recommended upgrade version available with Office Resource Kit

The Office Resource Kit has an upgraded version of the Setup.exe for Office 2000. It is recommended you use it for all your deployment needs. This version has increased string space for complex or long [Options] lines (such as ADDLOCAL, ADVERTISE, and ADDSOURCE found in the setup.ini). This is important if you are creating staged deployment scenarios where the ADVERTISE line can become very lengthy due to long PropName=PropValue associations (feature names, see filelist.xls in the Office Resource Kit tools section). Currently, the shipped version of Setup.exe can only pass a PropName=PropValue pairing of no more than 1024 characters. With the upgraded version available within the Office Resource Kit, it is possible to pass a pairing of 32,768 characters, however Windows Installer can only accept a 1024 character pairing.

The upgraded version of Setup.exe is nearly identical to the Setup.exe shipped with Office 2000 except for the following:

· Larger string variable handling for the [Options] section.

· An SMS correction for Rollback failures.

· An increased security buffer for really long security group strings.  If the administrator is a member of a large number of global groups, Setup.exe may not recognize the admin state, preventing Setup from launching on Windows NT.

· An increased stack area to reduce possible corruption of variable space.

· A new command line option /chained that allows for chaining several installs together into one process. See the topic “MultiLanguage Pack installation – US and MultiLanguage packs single install example” for information on how to use this new feature.

You can find the upgraded Setup.exe on the Office Resource Kit CD at:

<CD Root>:\PFiles\ORKTools\ToolBox\Tools\SETUP\SETUP.EXE or search the http://www.microsoft.com/office/ork/ web site.

Setup.exe – UNC versus Drive letter startup issue

An administrator may want to control the form of the path (UNC vs. mapped drive) used by Office 2000 to access the source location after an install. Unlike previous versions of Office, this is not determined at the time the Administrative installation is performed. The only control of the path form for Windows Installer packages is the path used to reference the .msi file.

For example, if a user has a drive mapped to the Setup.exe location and the .msi Windows installer package, but launches setup from a UNC path (i.e. using the Run option and entering a fully qualified UNC path to the Setup.exe), the controlling element is the UNC path. The Setup.ini, by default, contains only a filename reference to the .msi file.

If an administrator wants to explicitly control the path used by the Setup.exe, but does not care how a user starts Setup.exe, they can modify the Setup.ini file in the source location. To do so, add a fully qualified UNC or drive letter path to the .msi file entry in the Setup.ini. When setup is complete, all references to the source location in the System Registry are then of the path form used to reference the .msi file.

Setup.exe and batch files – using the “start /wait” prefix

If you use batch files as part of your setup process for Windows 95 or Windows 98 clients, use the “start /wait” prefix. This is not required for Windows NT 4.0 or Windows 2000. If you need to have one batch file for all versions of Windows, use the following example of batch file code as a means of detecting the version of Windows currently in use.

rem Detect the Operating System

if “%OS%”==”Windows_NT” set start= 

if “%OS%”==”” set start=start /wait

rem Call Office Setup

%start% setup.exe /wait /qb

Note: In the second line of the example batch file code (if “%OS%”==”Windows_NT” set start= ) there must be a space after the “start=”.

Setup.exe and Msiexec.exe – “/t” command line option syntax usage difference

If you use Setup.exe with either /jm or /ju (advertise) with the /t command line option, the /t requires a space between the option switch and the input parameter. Unlike Msiexec.exe, which requires no space, Setup.exe requires the space to properly locate and identify the name of the appropriate transform you want to use. For example:

msiexec  /ju <path>\install.msi /tYourTransform.mst

setup  /ju <path>\install.msi /t YourTransform.mst

Shared components/files – Making sure local applications do not fail when other Run From Network applications are installed and the network share is unavailable

If you want shared components to be installed locally, set the top branch (in the Custom Installation Wizard) to “local,” then change the sub features to RNS. It is not possible to segregate and have some components local and have others present on the network, they must either all be local or all on the network.

SMS Installations – Additional information on deploying Office 2000 with SMS (modified 8-27-99)

The topics in the Office Resource Kit chapter entitled “Deploying Office with Systems Management Server,” present a high-level overview of using Systems Management Server to deploy Office 2000. For important information on installing SMS and detailed procedures on using it to deploy Office 2000 with the supplied PDF files, see the SMS documentation available on the Microsoft World Wide Web site at: http://www.microsoft.com/smsmgmt. This information will be available after the release of Office 2000.

Staged Deployment and existing earlier versions of Office

If you plan a staged deployment of Office 2000 applications to systems with existing installs of earlier versions of Office, and you have changed the default removal properties of setup, you should use the Office Removal Wizard prior to running setup for any subsequent staged deployments. If you use Office Setup (OPC) with the default settings, it removes all prior Office applications. The first time an Office 2000 application is installed with a modified transform, it will remove the prior Office version applications per the settings in your transform. However, the next time you attempt to install an Office 2000 application to the same system, it will not remove any previous instances of Office applications. Setup will continue though, and you will end up with both versions of the selected Office applications on your system. Using the Office Removal Wizard ensures you will not have a mixed registry and directory configuration. Make sure you run the Office Removal Wizard before you run setup.

Terminal Server – Motionless Office Assistant – Install considerations (modified 8-27-99)

If you intend to configure an Office 2000 installation for use on a Terminal Server system, use the Terminal Server transform (termsrvr.mst) supplied with the Office Resource Kit. Before you install Office, make sure all the Office Assistants are set to “Not Available” (in the features panel of the Custom Installation Wizard). Office 2000 automatically takes advantage of the motionless Office Assistant when you use the supplied transform available from the Resource Kit. Currently, the Office Logo is the only assistant available without animation.

The Motionless Office Assistant optimizes your communication link with the Terminal Server from the client computer and provides for faster interaction with the system.

Terminal Server – Recommendation for Windows NT 4.0

If you are using Windows NT 4.0 Terminal Server with Service Pack 3 installed, and have users taking advantage of Terminal Server, it is highly recommended that you install the Windows NT 4.0 Service Pack 4 for Terminal Server update. Service Pack 4 includes updates to Terminal Server multi user features. Installing the Service Pack 4 update prior to installing Office 2000 installs the latest updates for Terminal Server and allows Office 2000 to properly take advantage of all the advanced features of the latest release of Terminal Server

Note   Do not install service packs for Windows NT 4.0 (non terminal server) if they are not specifically designed for Windows NT 4.0 Terminal Server. Non Terminal Server related service packs do not include the appropriate updates for the multi-user environment of Terminal Server.

Tools or Information – Most recent or up-to-date

Check the http://www.microsoft.com/office/ork/2000 Web site for new or updated tools. Also, check this site on a regular basis for new information or articles about issues you may encounter where help or other sources do not provide the information you need.

Errata

Glossary

Add the following item to the Glossary:

NEWPROF.exe – Reads the contents of a .prf file to create an Outlook profile. Outlook uses profiles to store information about a user’s e-mail servers, where Outlook information is stored (on the server or in a local file), and other options. The Office Resource Kit contains a sample .prf file (outlook.prf) for use in creating an Outlook profile with the Exchange Server service and an Internet E-Mail service.

Installing Office 2000 in Your Organization – Deploying Office 2000 – Installing Office in a Windows Terminal Server Environment – How to Install Office Disc 1 on a Windows Terminal Server – Set default Office application settings

The paragraph:

On the Tools menu, click Options, and then click the Preferences tab. Click Calendar Options and clear the Use Microsoft Schedule+ as my primary calendar check box.

Should read:

On the Tools menu, click Options, and then click the Preferences tab. Click Calendar Options and clear the Use Microsoft Schedule+ as my primary calendar check box. Schedule+ does not run with Terminal Server and must be disabled. It is advised to uninstall Schedule+ or change the related policy under the “Microsoft Outlook 2000 – Prevent users from changing primary calendar application.”   Set the “User cannot change primary calendar app” check box to checked.

Installing Outlook after Office 2000

Step 6 should be removed from the procedure. Instead, the following action should be carried out prior to the procedure:

Before performing the following steps, if there is an existing installation of the current Office 2000 application already on the target system, it should be uninstalled just prior to the installation of Outlook 2000 and should have no user prompts or User Interface dialog displayed to the user.

Office 2000 System Policy Reference – System Policies in the Windows Installer Policy Template

Below the “USER SETTINGS” heading, cross out the following policy:

“Pin transform at Transform source”

Office 2000 System Policy Reference – System Policies in the Windows Installer Policy Template

Add the following policies under the “MACHINE SETTINGS” heading and below the “Disable Patching” policy.

Allow user control over installs

Disable IE security prompt for Windows Install scripts.

Tools Information – Terminal Server Tools – Other support information for Windows Terminal Server

The table entry:

Termsrvr.mst  Provides the transform (.mst file) used to install Office on a Terminal Server computer

Should read:

Termsrvr.mst
  Provides the transform (.mst file) used to install Office on a Terminal Server computer.

This transform installs all components and sets Outlook to Corp mode by default.

Upgrading to Microsoft Office 2000 – Upgrading to Outlook 2000 – Upgrading fromMicrosoft Schedule+ 7.x

All references to Schedule+ 95 should be changed to read Schedule+ 7.x. Schedule+ 95 is Schedule+ 7.0.

Upgrading to Microsoft Office 2000 – Upgrading to Outlook 2000 – Sharing Information with Microsoft Schedule+

The paragraph:

Note: Outlook 2000 users with Corporate/Workgroup e-mail support have the option to substitute Microsoft Schedule+ 7.x for the Outlook Calendar.

Should read:

Note: Outlook 2000 users with Corporate/Workgroup e-mail support have the option to substitute the Outlook 2000 Calendar with the Microsoft Schedule+ 7.x calendar. However, a user must have Schedule+ 7.x installed if they intend to use it as their primary calendar. Schedule+ 7.x is not installed as part of Outlook 2000.

Upgrading to Microsoft Office 2000 – Upgrading to Outlook 2000 – Upgrading from Microsoft Schedule+ 1.0

The sentence:

You have the option to use either Microsoft Schedule+ or the Microsoft Outlook 2000 native Calendar as your calendar client.

Should read:

You have the option to use either the Microsoft Schedule+ 7.x or Microsoft Outlook 2000 native Calendar. Releases of Microsoft Schedule+ prior to 7.x are not supported for use as the primary calendar within Outlook 2000.
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